
GrabIt Professional Help Index

This help file is designed to provide you with a quick and easy way to learn more about GrabIt 
Professional. If you have a question not covered here please check the program documentation and the 
read.me file.

File Menu Commands 

Edit Menu Commands 

Grab Menu Commands 

Capturing Menus With GrabIt

Marking Selected Areas Of A GrabIt Child Window

Important User Info and Commands

Window Menu Commands 

Obtaining Technical Support 

Accelerator Key Reference 



File Menu Commands

This Index lists Help topics for the File Menu. 

Open 

Save 

Print 

Run Clipboard 

Exit 



Edit Menu Commands

This Index lists Help topics for the Edit Menu. 

Copy To The Clipboard 

Paste From The Clipboard 



Grab Menu Commands
This Index lists Help topics for the Grab Menu. 

Grab Selected Area 

Grab The Entire Window 

Grab The Client Area 

Grab The Windows Desktop 

Hide The Window Menu Switch 



Window Menu Commands

This Index lists Help topics for the Window Menu. 

Window Tile 

Window Cascade 

Window Arrange Icons 

Window Close All 

The Windows List 



Opening An Existing Graphic

To load a bitmap from disk select File from the main menu and choose Open, or 
press Ctrl + O. You can select a bitmap or RLE file from the listbox,    or use the directory listbox to move to the 
location of your bitmap.    Alternately you can double click on the file name to load the image.

In addition,    the open file dialog allows you to examine the image attributes of a bitmap before opening it . To 
use this feature press the Image Info button



File Save

Choose File Save from the main menu.    Enter the file name of the bitmap in the edit field.    
You can convert between various formats by choosing the Options Button on the save dialog.
The options are as follows:

Bitmap Options Color Options
Windows 3.X Bitmap Monochrome
OS/2 2.0 Bitmap 16 Color
16 color RLE 256 Color
256 Color RLE 24 Bit Color

For users making screen shots for documentation and other presentations,    You can convert 
your screen shoots to monochrome on the fly by choosing the monochrome option when 
saving your screen grabs.

 Please Note The Information Below!

File Conversions
Converting from one format to another.    Don't convert 24 Bit or 256 color bitmaps to monochrome when 
you are using a 256 color driver.    This may result in a loss of portions of the image and could turn the 
image to solid black.

You can safely convert 16 color bitmaps to monochrome when running a 16 color driver.

You may have other conversion gremlins depending on the graphics card you have. Actually its a function
of the drivers that came with your card that may cause you a problem.    I use the standard 800X600 
windows driver anytime I want to convert graphics from one format to another.    This will eliminate many 
of headaches in the long run.

The color radio buttons are only functional for legitimate combinations of image and color 
options.





Print

This option will copy the currently active windows image to the printer. Your bitmap will always be 
stretched to fit the entire page.    The print function is intended to provide you with hard copy of larger 
screen grabs.    Icons and smaller size bitmaps will be stretched out of proportion.    The printing process 
is VERY SLOW so please allow for this so you don't end up canceling your print job.

Image Scaling
GrabIt Pro will size the image currently in its client area to the size of the current page defined in your 
printer setup. This means that very small    bitmaps will be enlarged to 8 1/2 x 11" if that is the current 
page definition. This is done so that on full screen captures and images loaded from disk you will get a 
1:1 aspect ratio printout. If you wish to print images in a smaller format, simply change your printer setup 
to reflect a smaller page size.

    Note: If you have any trouble with a bitmap printing correctly with a HP Laser Jet printer you should 
obtain the new Laser Jet printer driver from the Windows 3.0 or 3.1 supplemental driver disk.    If you are 
using Windows 3.0 then you will definitely need the new printer driver.    These drivers are available on 
Compuserve and many BBS systems.    They are also available on our BBS at 602-375-0531 (2400) or 
602-375-9945 at 9600 baud.    If you are using a Postscript printer it will take longer to complete the print 
job than on a PCL printer.



Run Clipboard

This option lets you quickly check the contents of the clipboard to make certain it contains the image you 
intend to paste, or to check that the last copy command you issued is indeed in the clipboard.



Exit
This will end your current GrabIt Professional session.



Copy Window or Selected Area To The Clipboard
To copy text or graphics

1. Select the area or the child window you want to copy.
2. Choose Edit Copy or press Ctrl+Ins.
3. Choose Edit Paste or press Shift+Ins.



Paste An Image From The Clipboard.
To paste text or graphics

1. Choose Edit Paste or press Shift+Ins. If the clipboard is empty you will receive an 
error message.
2. The pasted image will be displayed in its own child window.    The title bar will say 
pasted, and will list the size of your pasted image.



Grab A Selected Area
To capture a portion of the screen follow the steps outlined below:

1. Click on Selected Area from the Grab Mark menu selection or press Ctrl + M
2. The GrabIt window will disappear (if you have the hide window on grab menu item
checked.)and the cursor will change into a crosshair.
3. Move the cursor to the UPPER LEFT HAND CORNER of the area you wish to 
capture.
4. Press and hold down the LEFT mouse button.
5. As you move the mouse you will see that the area you are marking will be changed

to 
inverse video.
6. When you have marked the area you wish to capture release the mouse button.
7. The Image will be displayed in a child window.    



Grabbing An Entire Window
To capture an entire Window follow the steps outlined below:

1. Select Entire Area from the Grab menu or press Ctrl + W
2. The GrabIt window will disappear and the cursor will change into a net with a 
crosshair.
3. Move the cursor to the Title Bar of the Window you wish to capture.
4. Click on the title bar.
5. Your window grab will be displayed in a child window.



Grabbing The Client Area
To capture the window client area only (no caption bar) follow the steps outlined below:

1. Select Client Area from the Grab menu or press Ctrl + C
2. The GrabIt window will disappear and the cursor will change into a net with a 
crosshair.
3. Move the cursor to the client area of the window you wish to capture.
4. Click on the client area.
5. Your client area grab will be displayed in a child window.



Grabbing The Entire Desktop
To capture the entire Windows 3.X desktop follow the steps outlined below:

1. Select Desktop from the Grab menu or press Ctrl + D
2. The GrabIt window will disappear 
3. Your desktop grab will be displayed in a child window.



Hiding The Window When Grabbing An Image
You have the option of not having GrabIt hide its window.    This could be useful if you were 
going to mark a selected area that was within the GrabIt client area.



Window Tile 
Tile
Arranges open windows side by side so that all of them are visible. 



Window Cascade Command
Cascade
Arranges open windows so that the title bar of each window is visible. 



Window Arrange Icons
Arrange Icons
Arranges into rows all the currently open screen grab windows that are minimized. 



Window Close All
This is a rapid way to close all current screen grab windows. The program will NOT ask you if
you want to save any of the screen grabs currently displayed.
Please be careful that you don't accidently close a window before you had the chance to 
save to disk.



The Windows List

This list will expand as you continue to grab screens or open files from disk.    When full,    the
last line will display the text; More Windows...    When you select this option you will be 
presented with a dialog box containing a list of all the currently open windows. Choose a 
window by selecting it from the menu item or from the select window dialog box as 
displayed below.



Trouble Shooting Help

If you are having trouble with GrabIt you have the following help options available to you.

Shareware Evaluation Users

You can get help by calling our BBS at 602-375-0531 (2400 Baud) or 602-375-9945    (9600 
Baud)
Leave a message to the sysop regarding your problem. You will have an answer in a few 
days. 

You can Fax us with your problem at 602-375-9928.    We will return your answer by Fax only 
so be sure to include your fax number with your question.

You can leave a message in our compuserve mailbox.    Our CIS ID number is 72200,576

Registered Users

You can use the options outlined above, and you can also get direct phone help. Before you 
call for help YOU MUST HAVE YOUR REGISTRATION NUMBER READY. It will be the first thing 
we will ask you for when you call.

The tech support phone number is 602-375-9928 and is available from 9:00 am until 3:00 
pm Monday - Friday. 

Please Note: Arizona is on Mountain Standard Time All Year Long. When daylight savings is in
effect we are the same time as the West Coast. The rest of the year we are on the same 
time as Denver, 1 hour later than the west coast.



Accelerator Key Reference

Listed below are all of the keyboard shortcut keys.

Accelerator Key Reference

Action Key Combination

Open A File Ctrl + O 
Save A File Ctrl + S
Print A File Ctrl + P
Copy A Graphic To The Clipboard Ctrl + Insert
Paste A Graphic From The Clipboard Shift + Insert
Grab A Selected Area Of The Screen Ctrl + M
Grab The Entire Window Ctrl + W
Grab The Client Area Ctrl + C
Grab The Windows Desktop Ctrl + D
Hide Window When Grabbing A Screen Shot Ctrl + H



Capturing Menus With GrabIt

You may often need to capture the pull down menus of another application for inclusion in program 
documentation or training manuals. Follow these steps to capture a menu.

1. Display the menu you wish to grab.
2. Press the Print Screen Key on your Keyboard ( Print Scrn)
3. Now switch back to Grabit.
4. Press Shift + Ins to copy the entire contents of your print screen into a GrabIt child
Window.
5. Now move the mouse cursor to the UPPER LEFT HAND corner of the image that 
contains the menu you want to save.    Press and HOLD THE LEFT MOUSE BUTTON 
DOWN.
6. Drag the crosshair cursor to invert the area containing the menu.
7. When you release the left mouse button the area you marked will remain inverted.
8. Press Ctrl + Ins to copy that area to the clipboard.
9. Now press Shift + Ins to insert the new image into a child window.
10. That's all there is to it!    You now have a window that contains only the menu you 
need to use.
11. Save your new bitmap to disk



Tips and Other Important Information

File Conversions
Converting from one format to another.    Don't convert 24 Bit or 256 color bitmaps to monochrome when 
you are using a 256 color driver.    This may result in a loss of portions of the image and could turn the 
image to solid black.

You can safely convert 16 color bitmaps to monochrome when running a 16 color driver.

You may have other conversion gremlins depending on the graphics card you have. Actually its a function
of the drivers that came with your card that may cause you a problem.    I use the standard 800X600 
windows driver anytime I want to convert graphics from one format to another.    This will eliminate many 
of headaches in the long run.

Printer Problems
If you have a problem printing a bitmap, and you are using a HP LaserJet printer be sure that you obtain 
the new windows 3.1 HP Laserjet driver that is on the windows supplemental drivers disk.



Marking Selected Areas Of A Child Window

You may need to capture only a portion of a screen grab or file opened from disk. Follow these steps to 
capture a portion of a child window.

1. Move the mouse cursor to the UPPER LEFT HAND corner of the image that 
you want to save part of.    Press and HOLD THE LEFT MOUSE BUTTON DOWN.
2. Drag the crosshair cursor to invert the area you want to mark.
3. When you release the left mouse button the area you marked will remain inverted.
4. Press Ctrl + Ins to copy that area to the clipboard.
5. Now press Shift + Ins to insert the new image into a child window.
6. That's all there is to it!    You now have a window that contains only the area you 
selected.
7. Save your new bitmap to disk

 Special Note On Child Window Selected Area Captures 

When you mark an area of a child window the inverted rectangle will remain visible until you either click 
on the window again or select another window. You must clear the inverted rectangle in any child window 
before performing another screen capture operation.    The program has set the focus to that rectangle so 
that you may copy and paste it.    If you don't clear it before attempting another screen capture, it will be 
transferred to the windows desktop and become an inverted area in that window.

So just remember to clear the inverted rectangle from the current child window before you do any further 
screen captures. Remember to clear it all you have to do is click anywhere on the child window where the
rectangle is located, or click on any other child window.




